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From the Chief Editor's Desk
ello everyone! My name is Papawoob, and as Tim
mentioned in this space last month, I am assuming the
position of Chief Editor. Tim´s leadership will be missed,
but the show will go on.

H

We have several more interesting articles for your reading pleasure
this month. We have another chapter in the ongoing KDE User Guide
series, an explanation of that mysterious file, etc/fstab, and a brief
history of PCLinuxOS by Texstar himself!
We are also in the process of moving from mag.mypclinuxos.com to
pclosmag.com. I am inviting everyone to visit the new site and sign
up at the forums. You can let us know what subjects you would like
to see in the magazine, comment on things you have read, or just
browse through the articles from the past year.
I would also like to welcome two new members to the staff. Sean
Harrison and Vivek Srivastava. Sean will be assisting in the
production of the PDF version of the mag, and some writing and
proofreading. Vivek will also be writing and is responsible for the
great progress going on at our new website.
Time to end this so that you can get on to reading all these great
articles. Thanks to all our readers for your continuing support and I
hope to see everyone at www.pclosmag.com!
Anyone who feels the need to write a note or letter to the editor can
e-mail me at: jpaxton@nc.rr.com.
Papawoob

PCLinuxOS 2007 FINAL Released
Written by Texstar, Sunday, 20 May 2007

Texstar and the Ripper Gang are pleased to
announce the final release of PCLinuxOS
2007. Featuring kernel 2.6.18.8, KDE 3.5.6,
Open Office 2.2.0, Firefox 2.0.0.3,
Thunderbird 2.0, Frostwire, Ktorrent, Amarok, Flash,
Java JRE, Beryl 3D and much much more. Almost 2 gigs
of software compressed on a single self bootable
livecd that can be installed to your hard drive provided
it is compatible with your system and you like the
distribution. Over 5000+ additional packages available
after hard drive install through our Synaptic Software
Manager. Please note PCLinuxOS does not ship with
Win32codes or DVD decryption software. Proprietary
Nvidia and ATI drivers available after hard drive install.
In addition we'd like to give out a special thanks to the
PCLinuxOS community who stepped up last month to
help us out and kept us going. Thank you for all your
support and we'll keep working hard to bring you a
good Linux distribution you can be proud of. We also
want to thank Enki Consulting for providing hosting
for our website and ibiblio.org for hosting our
distribution.
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Letters to the Editor

DEAR OL' DAD GOT A NEW COMPUTER... WITH LINUX

Back in the 20th century, my dad took notice of all the commotion about this
newfangled thing call the Internet, and decided he wanted to see what it was all
about. Being retired and in his 70's at the time, he wanted to make sure he didn't
turn into an "old fogey" and get left behind. He bought what was then a fairly high
end home computer – a 350MHz Pentium II, with 64MB (count 'em, 64MB) RAM,
and a huge 6GB hard drive, running Windows 98SE. He had been using it ever
since... until recently, that is.
During our conversations over Mothers' Day dinner, he mentioned that he hadn't
turned the thing on for six weeks. Seems it just wasn't any fun anymore. With all
the necessary anti-virus and anti-spyware software running, coupled with the
huge downloads of signature updates that greeted him at every boot, it was
taking forever just to get to a usable desktop. Couple that with a slow dialup
account trying to load web pages that were by now much more content heavy
than back in the old days, and the once fun and exciting Internet experience had
turned to drudgery. And then there was the spam...

He told me it was time to either do something different, or get out. So that's when
I made my pitch:
I told him that if he got himself hooked up to a high speed connection, that I
would fix him up with a new computer, running Linux, that would be faster, be
just as easy to use as his old one, and wouldn't be vulnerable to viruses and
spyware and all that nonsense. And that we'd take care of his spam problem, too.

The old goof took me up on it! A week or so after we'd talked, he called me to say
that he'd ordered DSL, and that the kit would be delivered within the week. It was
time for me to make good on my promise.
Hardware wasn't a problem – I have a collection of old, "obsolete" computers that
I've rescued from the landfill or been given directly. I've taken to refurbishing
these old machines, upgrading their hardware with pieces from other old
machines that I've cannibalized, and finding good homes for them. Dad was to
become the proud owner of an old Dell PIII/700MHz, with 384MB RAM, and a
13GB hard drive. What I had to do was decide on the particular flavor of Linux
operating system I wanted to put on it.

I've been dabbling in Linux for over two years now, and recently made a wholesale
transition to desktop Linux for my personal computing environment. I'm no guru,
but what I am able to do is install and configure most any mainstream
distribution. Believe me, I've tried a bunch, and have come to the conclusion that
for the unsophisticated home user looking to transition from Windows you can't
beat PCLinuxOS. I won't bother you with all the technical details – suffice it to say
that PCLinuxOS looks, acts, and feels like Windows, only better.
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That's what he got – a PCLinuxOS Linux computer, set up for basic email, Internet,
and word processing. The high speed connection setup was automagic – once the
DSL modem was configured (which did require using Windows, but blame that on
AT&T, not Linux), PCLinuxOS connected immediately on the first boot. The icing
on the cake was when I crossed my fingers and went to set up his old Lexmark
printer, and it was already there!
What followed was a short session that consisted of showing him what buttons to
click to do what -- "click this button to go on the Internet", "click this button to
read your email", and "click this button to write letters". That's been it.

He's been on his own for a month now. So far, so good. You must understand that
my dad barely knew how to operate his old Windows computer – he never learned
to save documents (all those scathing Letters to the Editor got printed and snailmailed), never learned how to use the Internet Explorer Favorites, and never
learned how to use the Address Book in Outlook Express. He actually is the
perfect candidate for desktop Linux, as he doesn't have any ingrained
expectations about how a computer should behave. I'm encouraged by the fact
that he recently said he'd spent two hours reading sports blogs just that day,
and then asked me how to find the Daily Kos. I've gotten two "support" calls so
far, both having to do with setting up his Address Book. He's got the hang of it
now.
Once again, you may ask "what's the point?" There are several, but for the
purposes of this essay, I'll be brief and leave it at this:
Desktop Linux is ready. If Dad can do it, anybody can.
Mark Warner, Bloomington, Indiana, USA

Thanks for the inspirational story, Mark. Many of us have similar stories, but
few of us have put them into words as succinctly as you. Papawoob

Our grateful appreciation to MyPCLinuxOS.com
and Devnet for making this project possible.
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I would like to thank you guys for publishing the magazine that you do. I've taken
a look at it from time and time and have been very impressed with the heart-felt
stories being told by living, breathing, everyday people. I think you might find this
tidbit interesting. I have been distro-hopping for quite some time now. The
purpose: find the distro that would work right for me as I am working on THE
*NIXED REPORT, the online magazine. Debian 4.0 Etch almost became the main
distro of choice. Almost. There was one thing holding it back: Skype 1.4 beta. I
did not wish to use that version of Skype as I figured out very quickly that it had
tremendous problems (i.e. sounding like a tin can, etc...). 1.3 works perfectly, but
skype.com never offered 1.3 at that point... it was either 1.4 or don't bother at all.
I also do a radio show and podcast with my co-host Justin Breithaupt of
mindblowingidea.com. For that reason, I have chosen the main distro for business
related things: PCLinuxOS 2007. Not only does it work very well, but it also
detects my media card reader, external drives (hard drive and DVD-burner), and
my HP scanner/copier/printer. Finally, there is a copy of Skype 1.3 in the
PCLinuxOS repositories. Thanks so much for offering an excellent publication,
and may there be many more issues to come. :)
Thomas Holbrook II
Founder and Editor in Chief
THE *NIXED REPORT: Unix and Overlooked Pop Culture

Thank you very much, Mr. Holbrook for your inspirational letter. The staff and
myself greatly appreciate when someone has found value in our labors, as do
the development team. Papawoob
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PCLinuxOS - A little walk down history lane
from a post by Texstar
http://www.pclinuxos.com/index.php?option=com_smf&Itemid=26&topic=29104.msg223220

In the summer of 2003, I became interested in LiveCD technology after looking at
Knoppix and a fresh distribution from a fellow named Warren called Mepis. I was
interested in helping Warren with Mepis at the time but I had no clue how to build
Debian files. Coming from 5 years of packaging RPMs and not really wanting to
learn a new packaging system, I happened to come across a South African fellow
by the name of Jaco Greef. He was developing a script called mklivecd and porting
it to Mandrake Linux. I, along with Buchanan Milne (Mandrake contributor), and a
few others began working with Jaco to help debug the scripts. I got an idea to
make a LiveCD based on Mandrake Linux 9.2 along with all my customizations
just for fun. I had previously provided an unofficial 3rd party repository for the
users of Mandrake for many years but had since parted ways. Since Mandrake was
a trademarked name, I and others decided to name the LiveCD after our news site
and forum pclinuxonline, thus PCLinuxOS.
Preview .3 was my first attempt to make a LiveCD. I distributed it initially to about
20 people to get their reaction and feedback. Everyone who tested it loved the
LiveCD but there was one thing missing. There wasn't a way to install the thing to
the hard drive! srlinuxx from tuxmachines.org came up with a novel way to copy
the LiveCD to the hard drive and posted it on our forums. Jaco utilized this
information and inspiration from the Mepis installer and wrote a PyQt script to
make the LiveCD installable thus the birth of a new distribution.
On October 24, 2003, PCLinuxOS Preview .4 was released as a fork of Linux
Mandrake (Mandriva) 9.2 utilizing mklivecd scripts from Jaco Greef, a multimedia
kernel from Thomas Buckland (2.4.22-tmb) and a customized KDE (3.1.4-tex).
Preview .5 through .93 were built upon on previous PCLinuxOS releases. After 3
years of updating one release from the other using the same gcc and glibc core
libraries, we found too many programs would no longer compile or work properly
against this aging codebase.

In November 2006, we utilized a one time source code snapshot from our friends
at Mandriva to pull in an updated glibc/gcc core and associated libraries. We
spent the following 6 months rebuilding, debugging, customizing, patching and
updating our new code base. We pulled in stuff from our old code base, utilized
patches/code from Fedora, Gentoo and Debian just to name a few. This is why
you will never see me distro bashing as it would be hypocritical to do such a thing
since we are still dependent in many areas on other distros development
processes due to our limited but hardworking volunteer development team.
On May 20th 2007, we felt we had reached a pretty stable base and released
PCLinuxOS 2007 utilizing our own kernel from Oclient1, KDE built by MDE
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developer Ze, updated mklivecd scripts from IKerekes & Ejtr, a heavily patched
Control Center, graphics from the PCLinuxOS Beautification Team and many
application updates from Thac and Neverstopdreaming. Development continues
as work is being done for a MiniMe release and an international DVD. A future
release of PCLinuxOS will feature an updated kernel, KDE 4, fresh Xorg server and
all the latest applications. All in all it has been a great ride and we have made
many friends along the way. Some have gone on to other distributions and many
are still here from our first release. As I've always said, we're just enjoying Linux
technology and sharing it with friends who might like it too. We hope you have
enjoyed the ride as well.
Here are some screenshots from some of our previous releases. (Click on the

thumbnail to view the 640 x 480 image on your browser)
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Preview 7 brought in KDE 3.2.3. We were still on the 2.4 kernel using devfs as
udev didn't exist as yet.

Preview 8 had my favorite LiveCD boot splash with Tux in a cowboy hat and a 6
shooter. Preview 8 was a troublesome update for many as we switched to the 2.6
kernel series along with udev replacing devfs.

PCLinuxOS - A little walk down history lane

Preview .91 brought in the 2.6.11 kernel from ocilent1, graphics from J Rangels
and KDE 3.4.1
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Preview .92 was probably my favorite release graphically until our 2007 release.
Some of our friends said it was really pretty if you like blue! This release provided
updated kernel to 2.6.12 and KDE 3.4.3.

PCLinuxOS International

Ubuntu's Hype is Misleading [Real Test]
by Anant Gowerdhan
I'm running a computer institute and I have new, middle and advanced users.
People who know Linux very well and those who don't even know "L" of Linux.
Recently I'm trying different distros. Trying a distro is always based on the reviews
I read on the web. Most of the reviews are based on stability and performance but
none of them I found which is meant for a normal user who is a new user in the
Linux world. This time I thought, lets do it practically, give different distros to my
people in the Institute and get their opinion. For this I chose Ubuntu, PCLinuxOS
2007, Dreamlinux, and Mandriva One.

The most misleading hype I got is about Ubuntu, they say that "its a replacement
for Windows", "Windows users will feel they are home". I don't know why they have
created such hype when it's not at all true. I agree that Ubuntu has the largest
community and they are have a stable OS, but back to reality, I'm testing different
distros from the normal user point of view. Users who'll like Linux and leave
Windows, means it should be as easy as Windows for them. I've given each distro
a day and asked everybody to do their daily work on it.

MANDRIVA ONE
A beautifully designed distro, looks pretty, and its fast and stable. My users gave
me a good feedback for this distro when it comes to stability and performance,
but they were not able to run websites like YouTube and some of the online News
channels. They were not able to run DVDs and some of the Win32 format avi files.
It is because this distro doesn't contain any proprietary software. They reported
another problem that is when they click on "My Computer" they see only Linux
partitions, but no Windows partitions (not even FAT32 partitions) are there, so
accessing files from a Windows drive is a pain. Installing software from the
repository is easy, but the repository is not very good, a normal user doesn't find
Skype, Gizmo and Win32Codecs, which is proprietary software in their non free
section.
So at the end my users (Normal and Advanced) both rejected it to replace
windows for their personal use.

DREAMLINUX MMGL
Its a fantastic distro with lots of eye candy and full of multimedia features. It uses
Debian's repository so a normal user can find everything in the repository. My
users tried it for a day and they were very happy with the performance, it was 20
times faster than Windows on the same machine. Everything worked smoothly.
Websites like Youtube worked out of the box, and it was supporting all the media
format. There were some difficulties because XFCE works differently than
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Windows desktop (like right clicking on the desktop to change the desktop
wallpaper.) Other than small issues my users were very happy with this distro, but
there are a few stability issues. When they tried to run Amarok, it ran and
suddenly it crashed, it happened to most of the users, I think its because KDE libs
are not supported properly by XFCE. Killing a running application is also a pain,
because if you press CTRL+ALT+ESC, you can kill an application which is stuck,
but not when the program is stuck in memory and you don't have any GUI to work
with. Some of my new users used the above key combination and when they
clicked on the desktop, their desktop was gone. When they restarted, it came
back.
Well the overall review of this distro was very good and 6 out of 10 users said
they may think of replacing Windows on their personal laptop or home computer.

PCLINUXOS 2007
PClinuxOS 2007 is my all-time favorite and I wanted my people to test it and give
me some positive feedback. When I gave it to them to test for a day, they gave me
extremely strong feedback. They were able to share their Window drives and it
was as fast as Dreamlinux, all the media were running flawlessly and it didn't
crash in all day use. CTRL+ESC worked as good as CTRL+ALT+DELETE in Windows
and in fact, it worked better than that. They found everything worked out of the
box, Messenger with Video chat to Yahoo, The best CD burning program K3B and
KTorrent is the best torrent tool. It was able to detect plug and play devices as
good as Windows. One of my users attached his Digi Cam and his photos opened
in DgigiKam. He was very impressed because for the same thing he had to install
a driver plus the album software on Windows.
Well, the overall review of this distro was fantastic (as I knew) and 10 out of 10
users said they will (not may) be replacing Windows on their personal laptop or
home computer immediately.

UBUNTU 7.04
Well, what is there to say about this distro? It has a hype that it's for the user who
are switching from Windows. I gave it to my users for a day and the review was
like this. One guy told me that "If this is what best Linux is, I'll never move from
Windows because its not as user friendly as PCLOS and Dreamlinux." My 10 out of
10 users reported that it is running slower than Windows on the same machines.
It doesn't support any proprietary tools or software out of the box and for many
things you need to know the Linux command. It expects you to go back to the
command line and do some tweaking there. The experiences of my users were not
good, they said its not at all user-friendly and it's slower and doesn't act like
Windows at any point. It's not a replacement of Windows. They said, "it could be a
stable OS but I'll never move to Ubuntu even if it's the only distro in the Linux
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world." They also said that they would prefer "Mandriva One over Ubuntu 7.04
because its at least faster and it doesn't expect users to go to command line."

So overall review of Ubuntu was the worst from new user point of view and PCLOS
wins here. My users say that in their opinion, Ubuntu has misleading hype, it's not
for the normal user. It is for those users who knows Lnux very well and have high
end systems (with over 1Gb RAM).
That ended the 4 days of testing. All of my 10 users took PCLOS LiveCD from me
and they installed it on their home PCs and personal laptops. I wish Texstar &
PCLOS team the best of luck for the future releases and I believe we'll be able to
see some more stable, fast, and user friendly releases.

The PCLinuxOS Hardware Database

Do Faster Downloads With ProZilla!
by Jerry L Kreps, aka GreyGeek
One evening a few weeks ago I was engaged in one of my favorite pastime
activities: surfing the repository to read the descriptions of the applications it
contains! One application raised my curiosity. It was named “ProZilla”. The
description stated:

A multithreaded download accelerator
ProZilla is a multi-threaded download accelerator for Linux which supports both
HTTP and FTP protocols. It makes multiple connections to the server and
downloads the file in portions, thus giving a much better speed rate than the
conventional download programs which use a single connection. Resuming
connections is fully supported and customizable.

INSTALLING PROZILLA, AND TRYING TO INSTALL ITS GUI
I installed ProZilla using Synaptic and began looking for its GUI in the menu
structure. No joy. So, I ran the KDE menu update tool. Still no joy. Then it dawned
on me: ProZilla didn't include a GUI. I went to the ProZilla website,
http://prozilla.genesys.ro, and found a GUI there. I also noticed that development
for ProZilla had essentially ceased more than three years ago on that site. The GUI
offered was the Mandrake version, dated June 29, 2004. I tried to install the
Mandrake version with KPackage and got an error message about missing
dependencies. Despite that error message it appeared that a GUI of some sort was
installed! I ran it only to find that it crashed when I directed it to an ISO file on the
Internet. I removed it using KPackage, and ran “fix broken packages” just for good
measure. Then I tried the static GUI rpm. A test install gave the message:

<ds/prozgui-2.0.4beta-static.i386.rpm';echo RESULT=$?
file /usr/include/prozilla.h from install of
prozgui-2.0.4beta-static conflicts with file from package
prozilla-devel-2.0.4-1pclos2007
file /usr/lib/libprozilla.a from install of prozgui2.0.4beta-static conflicts with file from package prozilladevel-2.0.4-1pclos2007
file /usr/lib/libprozilla.la from install of
prozgui-2.0.4beta-static conflicts with file from package
prozilla-devel-2.0.4-1pclos2007
RESULT=1
I used Synaptic to remove prozilla-devel-2.0.4-1pclos2007, because I had no
plans to do any development on ProZilla. Then I did a test install of prozgui,
which gave a “Result=0”. However, alas, the ACTUAL install resulted in the
message:
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</home/jerry/downloads/prozgui-2.0.4betastatic.i386.rpm';echo RESULT=$?
/var/tmp/rpm-tmp.77695: line 1: fg: no job control
error: %post(prozgui-2.0.4beta-static.i386)
scriptlet failed, exit status 1
RESULT=1
No problem. I'll just uninstall it. The uninstall gave me the same message!

Uh oh! An application that won't uninstall! The RPM package was improperly built.
That is a problem when one uses RPMs that are not from the PCLinuxOS
repository. I usually use KPackage when installing foreign RPMs. One of the
options is to run or not run the package scripts. I unchecked the scripts option
and redid the uninstall. The package was removed.

RUNNING PROZ
This left me with only one way to run the program, the command line. I opened a
Konsole and typed in “prozilla”. I was greeted with “bash: prozilla: command not
found”. So, it was named “ProZilla” in the repository but is saved under a different
name in the directory.
Note to New Users: I didn't enter “ProZilla” because Linux binaries are rarely
named using mixed or upper case characters.

Knowing that most executable applications or scripts are usually located in a bin
directory, I gave the Konsole another command:

[jerry@GreyGeek Laptop ~]$ locate bin/pro
/bin/procps3-kill
/bin/progress
/usr/bin/procmail
/usr/bin/profiles
/usr/bin/promisc_check
/usr/bin/protoize
/usr/bin/proxymngr
/usr/bin/proz
[jerry@GreyGeek Laptop ~]$
And there it was, the last entry! Now I needed to learn how to run it. Because I
know now that it is a curses or text based program I also know that I can use the
“man” pages to learn about it. I issued “man proz” in the Konsole window and
started reading.
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The basic command sequence I decided to use first was:

proz -v -f -s URL/to/distro.iso
where “-v” is the verbose mode, “-f” suppresses prompts on save, and “-s” does
an ftp search for faster mirrors. I had seen the announcement about the
PCLinuxOS Business Enterprise distro and decided to download it using proz.
Here is the command I issued:

proz -v -f -s http://pclosbe.org/BELServerBasicRC3.iso
I obtained the URL by browsing to the download directory, right mousing on the
file listing of BELServerBasicRC3.iso, and selecting “Copy link location” from the
pop up menu options. Then I typed in the first part of the command:

proz -v -f -s
and selected “Paste” from the Konsole “Edit” menu to form the complete
command.

When I issued the command the lines in the Konsole window were re-organized
and began displaying the results of the command. Here is what I saw:
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My first result was surprising. ProZilla's web page indicated that it would improve
download speeds by 200% to 300%. Since my download speed using FireFox just
after I used proz was around 230Kb/s, this was almost a 330% improvement! The
download time dropped from 53 minutes to 15 minutes.
I tried the same download again, this time using 20 threads. Here is the result:

The speed was at least 430% of my FireFox download time!! I'd much rather have a
12 minute download time than a 53 minute time.
I tried the download on my T3 line at work during my breaks Here are the results
for several thread counts:
Number of Threads Time
4 (default)
6 min 15 sec
10
2 min 30 sec
20
2 min 5 sec
40
1 min 40 sec

Ave Kb/s DL Speed
2000
4290
4700
6250

Obviously a T3 line is significantly faster than a 10Mb/s cable connection. Again,
I'd take less than 2 minutes over 53 minutes anytime, if I could afford a T3 line.
I decided to try downloading something from another site to see the difference a
site would make. I chose KNOPPIX:
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proz -v -f -s -k=10 ftp://ftp.freenet.de/pub/ftp.unikl.de/pub/linux/knoppix/KNOPPIX_V5.1.1CD-2007-01-04-EN.iso
And here are the initial results, just a few seconds into the download:

Notice that three of the threads were denied login. Later, as threads fulfilled their
quota, the denied threads were allowed to login and download their segments, as
shown below:
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Also notice that the initial download speed was a respectable 970Kb/s, which is
about 4 times my current FireFox rate. Some threads were faster than others,
sometimes by a factor of two. While testing other downloads I found that it was
normal for the download speed to taper off near the end as individual threads
finished their work, so ending up with a download rate of 903Kb/s isn't bad. I also
noticed that the “Current Speed” could be as much as 1.5 to 2 times the average
download speed. When the current speed drops below the average speed you
know that the majority of threads are finished and the download is near
completion.
Another comparison between a 10Mb/s cable and a T3 line

Here's the download of the 4.2 GB DVD version of Ubuntu-7.04 from my 10Mb/s
account using 20 threads:

The snapshot on the next page is the same download from my T3 connection:
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The download time dropped from over 1 hour and an half to under 15 minutes,
which gives you a good idea about the differences between a 10Mb/s connection
and a T3 line.

If I set “k=1” then proz downloads the Ubuntu DVD offering in 31 minutes and 10
seconds on the T3 line. If I use FireFox, even with 8 pipelines, I get only 483Kb/s
on the T3 line and FireFox reports it will take 2 hours 22 minutes and change.

SUMMARY
Using ProZilla is a definite time saver no matter what your connection bandwidth.
Occasionally ProZilla would stop downloading before completing its task and the
average speed rate would gradually diminish as time progressed. I noticed this
happened sometimes when I opened Snapshot on top of the Konsole window.
I googled around to see if there were other download accelerators available for
Linux and discovered two more: Prosilla and Axel. Neither are in development or
maintenance. Prosilla is also a command line application but has a slightly
different display format, as shown by snapshots on its web page, which show
ETA's on individual threads. I did not download and try Prosilla, but I did
download Axel from the repository. Unfortunately, it would crash every time I ran
it.

A Beginner's Guide to Linux, Part 1
by Vivek Srivastava
If you are reading this, I will assume that you are a newbie to Linux. Now, that
means that either you have bought a new computer with Linux preinstalled, or a
friend of yours told you to migrate from Windows to Linux. In the second case,
either you simply removed Windows and installed Linux, or created a dual-boot
system (one which gives you a choice to start Linux or Windows). Whatever the
case may be, you must read on further if you think yourself to be least
knowledgeable about the mysterious Linux world! I'm simply saying, “Welcome to
Linux”.

One question that few newbies ask me is "Is Linux some form of Windows?" NO!
Linux is an entire Operating System in itself. What is an Operating System? It is a
set of computer programs meant to manage the hardware and software of a
computer you want to run. Most of the distributions of Linux are freely available
through their websites, or through CDs/DVDs. “Distributions!! What are they?” I
know some of you might have had this thought. Linux is provided by many
organizations, or developers. They take the Linux kernel (the core of Linux),
combine it with a GUI/DE (Graphical User Interface or Desktop Environment) and
other software (which is also available for free), customize and optimize the
combination and make the entire combination available in the form of a
Distribution, or Flavor, free of cost. This entire "free" thing is the result of hard
work by many people who devote their time to make things available for us. A few
famous distributions are PCLinuxOS, Ubuntu, Fedora and Debian. There are many
more.
There are many Desktop Environments used by Linux Distributions. Some of them
are GNOME and KDE which are large and highly customizable, or Xfce and
Blockbox, which are smaller and use less resources. A few distributions offer a
choice in desktop environments, while many come with a default installation of a
particular desktop environment. For example PCLinuxOS comes with KDE and
Ubuntu comes with GNOME.

When you boot Linux, you are, in almost all Distributions, presented with a login
screen. If you installed Linux yourself, you would have chosen a root password
during the installation process. Or in the other case, your vendor must have
provided a root password to you. What's root? The root file system is kind of like a
file drawer that all other files are in. Before discussing root, let me explain the
concept of users in Linux. Linux is a multiuser system. Users can either have
administrative privileges where they can do anything, or they can have the
privileges of a normal user with restricted usage. Administrative users are called
super users, and the built-in super user account has the username 'root'. Linux
employs the concept of a home directory for each user. It is most useful for those
with restricted access. It is a directory containing the files of a user over which he
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has total control. Other users, barring super users, cannot alter the contents of
that directory, unless specifically permitted by the owner.

Once you have logged in with the correct user name and password, open the file
manager to observe the file system used by Linux. If you are, or were, a Windows
user, you might be totally confused by not finding your drives (C: , D: etc.). Linux
uses a different structure to store files. Your hard disk is divided into partitions,
or slices. Each partition has its own file-system, or a way of storing files. File
systems can be FAT, ext2, ext3, etc. Among the partitions you have is the one on
which you have installed your Linux. It is called the root file system (this "root" is
different from username "root"). When Linux is started, this root file system
becomes the main file system of the computer (and the main directory is “/”, also
known as root directory). Other directories are mounted in the /mnt directory.
The /bin contains binary and other executable files. The /home contains home
directories of all users other than root. The /root is the home directory of root
user. File permissions determine if a file is executable or not. Extension restriction
is generally imposed by the application using the file.
You might have heard a few of your geek friends talking about how the real power
of Unix/Linux lies in the command line. So where do you find the command line?
Here comes the role of the Shell, or Terminal. The shell is a command line
interface (like the old DOS) that takes command through typing. You may find the
shell or terminal located in the menu of the Distribution you are using. In
PCLinuxOS, go to Menu --> System --> Terminal --> Konsole to open a terminal
shell. Here you can type commands to be executed. For example, use ls to list the
content of a directory, cd to change a directory, and so on.
Now that you understand some of the basics of Linux, it is time to update Linux.
Update helps us to keep the computer secure in many ways. Moreover, you may
also want to install new software. That is why it is important to understand the
concept of packages. Linux uses .deb, .rpm, etc. files to install new packages.
These files are like installers in Windows. They contain the required binaries and
source code to be installed on the system for particular software. A good website
to find rpm files is rpmfind.net. The other method of updating your installation is
through package manager like apt, yum etc. These package managers also have
GUI front ends like Synaptic and KPackage. Many distributions use package
managers which keep a database of all the installed versions of packages.
Updating through package managers is the safest way to update and install
software as they also take care of dependencies (packages on which your software
depends). If you install without using package managers, you will have to
manually take care of all the dependencies yourself, which can be a hectic task.
Look on your distro's (short form of distribution's) website for help using the
package manager on your distro. In PCLinuxOS, go to Menu --> System -->
Configuration --> Packaging --> Synaptic Package Manager to open Synaptic.
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All said and done, we now come to a very important topic: Text Editors. Linux has
many text editors present like vim (I personally never recommend it to a newbie;
only mentioning it here because of its apparent popularity in the Linux community
amongst advanced users), Emacs, Gedit, Kwrite and many more. For editing office
documents, making presentations etc., office suites like OpenOffice, KOffice, etc.
are used.
With this, we come to the end of part I of this tutorial. We will see more of this in
the next issue. Till then, explore Linux as much as possible; but avoid doing so
with the root account. Make a new account for yourself with restricted usage
permissions unless you want to affect your installation badly ( I remember my
beginner's days, when I once had to install Linux seven times on a single day!).

Want to Give Up? A Word to the New and Frustrated
by Scooter
I've read a few posts in the Forum by newcomers to PCLinuxOS, who have, of
course, been acquainted beforehand with Windows. They speak of becoming
frustrated early on with learning how to use a new and different OS. Some elect to
return to the familiarity of Windows. I have a couple of points to make for novices
deciding to give up on the effort of learning Linux: a) Linux is not harder than
Windows, and b) with Windows, unless you know how to "harden" and secure it
properly, you and your data are in a position of serious risk.
Now this article isn't to bash Windows. I gain nothing from participating in that
kind of debate. In reality, Windows is fine to use, but it needs to be secured,
configured properly, and regularly maintained with security programs. Without
this advanced knowledge - which takes just as much time and learning as getting
to know Linux - using it is risky. A Linux install is relatively simple and quick to
secure, and inherently has no such vulnerabilities. A person who has come home
with a shiny new computer with Windows should know that their machine is not
secure and ready to go. There is much work to be done.
My sister-in-law's recent situation is a brilliant example of this. She brought her
Windows XP machine to me because her OS was in critical shape. After much
effort to just get it started, I found she had a reputable firewall and anti-virus
installed. Despite that, this is what I pried out of her XP: 126 Trojan viruses, 3
rootkit viruses, 389 spy-ware programs (dataminers, keyloggers) and 27 hijacks
(Trojans meant to allow hijacking of the machine by a remote user). Those were
just the ones I could actually find. In the end, after recovering her important files,
her drive had to be reformatted and XP reinstalled.

The following week, I performed similar surgery on another person's machine.
Same story. What did they have in common? Simple: both users had little or no
knowledge of how to properly secure the machine and perform regular checks, or
even of computers in general. Their personal data (passwords, financial info) and
files may have been stolen by these infections. Indeed, their machines may even
have been used by hackers for more evil purposes, all silently and without their
owners' knowledge.

This doesn't happen in Linux. And that is why I recommend it for new or less (yes,
I said less) technically-minded computer users.
With Linux, there is a learning curve, but it is no less than that of other operating
systems. Remember the first time you were faced with Windows? I do, way back in
1990, and I was just as lost as with my first gaze at Linux in 2005.
In Windows, most peripheral devices come with driver install CD's. Spin them up
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and Win easily does the rest for you. But security is up to you, and you better
know it before you even plug that Internet connection in (an improperly secured
Win box can get infected within 10 seconds of being connected to the Net).

In Linux, there is some simple user device configuration needed, unless you have
exotic hardware, and for more difficult issues there is a huge user support base.
However, security is as easy as clicking "Set Up A Firewall" in the PCLinuxOS
Control Center. Since viruses and spy-ware can't be run in Linux unless
intentionally made to do so by the user, or by installing compromised nonrepository third-party software (both of which require more advanced
knowledge), the only concern is closing up those open ports with the inbuilt
firewall and not running as the Root user.

Windows has the dreaded Regedit. Linux has the Command Line, but also the man
and apropos commands to explain to you in plain language how you use the
commands if you're stuck.
So this is for those beginners who want to walk away. Linux is not difficult, only
different from what you are used to. The frustration you feel is related to your
newness, it's not the fault of the OS. Learning takes time, just as it did with
Windows. Stay with it, be patient, don't let yourself get frustrated, and shortly it
will all make sense. And you have peace of mind knowing that you and your data
are very secure. Ten thousand plus members in PCLinuxOS alone, and many more
in the other distros combined, can't be wrong. And take note that we love to jump
in and help when 'New Friends' have questions or issues.
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How to Make a List of Installed Packages
by Hooke
There's a wonderful tool called "remasterme" that lets you build an installable live
CD or DVD from your current PCLOS system. However, there are times when you
may need something more lightweight, like a list of your installed packages that
you can later use to reinstall them using apt-get. Maybe you don't have a DVD
burner, or you want to make several slightly different versions, and don't want to
spend a DVD for each one. Another reason may be that you want to get a list of
installed packages from a PCLOS .93a system and install those packages
(by name, not version) in a PCLOS 2007 system.
Users of distros that have APT with the DPKG packaging system, which handles
".deb" packages (like Debian and Ubuntu) can use the commands:
dpkg --get-selections and dpkg --set-selections to do the trick.
PCLOS has the APT package manager, but not DPKG (it has RPM instead) and RPM
seems to lack this feature. But we can do it anyway, as follows:

First, let's save the package names to a file, say, in your desktop. Open a terminal
as root and type:

rpm -qa --queryformat %{name} \n > ~/Desktop/installed.log
This command tells the RPM program to query the names of installed packages,
building a list with the name of each package followed by a carriage return, and
then to redirect the output of this query to the file
/home/yourusername/Desktop/installed.log. Of course, you can save
it elsewhere. It's a text file. You can inspect it with
cat ~/Desktop/installed.log or kwrite ~/Desktop/installed.log
Then, when you want to use the list, just type (as root):

apt-get -y

install $(cat ~/Desktop/installed.log)

This tells apt-get to install the result of reading the package list we just created.
You can check the argument passed to apt-get by typing:
echo $(cat ~/Desktop/installed.log). You will see all the names of
the packages, separated by whitespace (the carriage returns go away), which is
the way you tell apt-get to install more than one package. The "-y" option is
indeed optional. It tells apt-get not to ask questions as long as nothing
dangerous happens, such as trying to remove essential packages. If you want to
test this command without actually installing anything, you can use the "simulate"
option. Just type:

apt-get --simulate -y

install $(cat ~/Desktop/installed.log)

For more information, just type man apt and man rpm. Have fun!

How to Understand and Edit etc/fstab
by Nana Långstedt <nana.langstedt at gmail.com>

Many other great articles can be found at Nana´s website, Tuxfiles.org.

There's a file called /etc/fstab in your Linux system. Learn what its contents mean
and how it's used in conjunction with the mount command. When you learn to
understand the fstab file, you'll be able to edit its contents yourself, too.
In this tuXfile I assume you already know how to mount file systems and
partitions with the mount command. If you don't, I suggest reading the Mounting
tuXfile before reading this one.

WHAT IS FSTAB AND WHY IT'S USEFUL
fstab is a configuration file that contains information of all the partitions and
storage devices in your computer. The file is located under /etc, so the full path
to this file is /etc/fstab.
/etc/fstab contains information of where your partitions and storage devices
should be mounted and how. If you can't access your Windows partition from
Linux, aren't able to mount your CD or write to your floppy as a normal user, or
have problems with your CD-RW, you probably have a misconfigured /etc/fstab
file. So, you can usually fix your mounting problems by editing your fstab file.

/etc/fstab is just a plain text file, so you can open and edit it with any text editor
you're familiar with. However, note that you must have the root privileges before
editing fstab. So, in order to edit the file, you must either log in as root or use the
su command to become root.

< OVERVIEW OF THE FILE >
Of course everybody has a bit different /etc/fstab file because the partitions,
devices and their properties are different on different systems. But the basic
structure of fstab is always the same. Here's an example of the contents of
/etc/fstab:
/dev/hda2
/dev/hdb1
/dev/cdrom
/dev/fd0
proc
/dev/hda1

/
/home
/media/cdrom
/media/floppy
/proc
swap

ext2
ext2
auto
auto
proc
swap

defaults 1 1
defaults 1 2
ro,noauto,user,exec 0 0
rw,noauto,user,sync 0 0
defaults 0 0
pri=42
00

What does all this gibberish mean? As you see, every line (or row) contains the
information of one device or partition. The first column contains the device name,
the second one its mount point, third its file system type, fourth the mount
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options, fifth (a number) dump options, and sixth (another number) file system
check options. Let's take a closer look at this stuff.

< 1ST AND 2ND COLUMNS: DEVICE AND DEFAULT MOUNT POINT >
The first and second columns should be pretty straightforward. They tell the
mount command exactly the same things that you tell mount when you mount
stuff manually: what is the device or partition, and what is the mount point. The
mount point specified for a device in /etc/fstab is its default mount point. That is
the directory where the device will be mounted if you don't specify any other
mount point when mounting the device.
Like you already learned from the Mounting tuXfile, most Linux distros create
special directories for mount points. Most distros create them under /mnt, but
some (at least SuSE) under /media. As you probably noticed when looking at the
example fstab, I use SuSE's mount points as an example.
What does all this mean? If I type the following command:

$ mount /dev/fd0
my floppy will be mounted in /media/floppy, because that's the default mount
point specified in /etc/fstab. If there is no entry for /dev/fd0 in my fstab when I
issue the command above, mount gets very confused because it doesn't know
where to mount the floppy.

You can freely change the default mount points listed in /etc/fstab if you're not
satisfied with the defaults your distro has given you. Just make sure the mount
point is a directory that already exists on your system. If it doesn't, simply create
it.
Some partitions and devices are also automatically mounted when your Linux
system boots up. For example, have a look at the example fstab above. There are
lines that look like this:
/dev/hda2 / ext2 defaults 1 1
/dev/hdb1 /home ext2 defaults 1 2

As you've learned, these lines mean that /dev/hda2 will be mounted to / and
/dev/hdb1 to /home. This is done automatically when your Linux system boots
up... if it wouldn't, you'd have a hard time using your cool Linux system because
all the programs you use are in / and you wouldn't be able to run them if / wasn't
mounted! But how does the system know where you want to mount /dev/hda2
and /dev/hdb1? By looking at the /etc/fstab file of course.
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< 3RD COLUMN: FILESYSTEM TYPE >
The third column in /etc/fstab specifies the file system type of the device or
partition. Many different file systems are supported but we'll take a look at the
most common ones only.

ext2 and ext3 Very likely your Linux partitions are Ext3. Ext2 used to be the
standard file system for Linux, but these days, Ext3 and ReiserFS are usually the
default file systems for almost every new Linux distro. Ext3 is a newer file system
type that differs from Ext2 in that it's journaled, meaning that if you turn the
computer off without properly shutting down, you shouldn't lose any data and
your system shouldn't spend ages doing file system checks the next time you
boot up.
reiserfs Your Linux partitions may very well be formatted as ReiserFS. Like Ext3,
ReiserFS is a journaled file system, but it's much more advanced than Ext3. Many
Linux distros (including SuSE) have started using ReiserFS as their default file
system for Linux partitions.
swap The file system name is self-explanatory. The file system type "swap" is
used in your swap partitions.

vfat and ntfs Your Windows partitions are probably either Vfat or NTFS. The 9x
series (95, 98, ME) all use Vfat (more widely known as FAT32), and the NT series
(NT, 2000, XP) use NTFS. In 2000 and XP you can choose the file system type, so
2000 and XP partitions may be formatted as Vfat, too. If you want to be able to
write to your Windows partitions from Linux, I suggest formatting them as Vfat,
because Linux's support for writing to NTFS partitions is a bit shabby at this
moment.

auto No, this isn't a file system type :-) The option "auto" simply means that the
file system type is detected automatically. If you take a look at the example fstab
above, you'll see that the floppy and CD-ROM both have "auto" as their file system
type. Why? Their file system type may vary. One floppy might be formatted for
Windows and the other for Linux's Ext2. That's why it's wise to let the system
automatically detect the file system type of media such as floppies and cdroms.

< 4TH COLUMN: MOUNT OPTIONS >
The fourth column in fstab lists all the mount options for the device or partition.
This is also the most confusing column in the fstab file, but knowing what some
of the most common options mean, saves you from a big headache. Yes, there are
many options available, but I'll take a look at the most widely used ones only. For
more information, check out the man page of mount.

How to Understand and Edit etc/fstab
auto and noauto With the auto option, the device will be mounted automatically
(at bootup, just like I told you a bit earlier, or when you issue the mount -a
command). auto is the default option. If you don't want the device to be mounted
automatically, use the noauto option in /etc/fstab. With noauto, the device can be
mounted only explicitly.
user and nouser These are very useful options. The user option allows normal
users to mount the device, whereas nouser lets only the root to mount the device.
nouser is the default, which is a major cause of headache for new Linux users. If
you're not able to mount your cdrom, floppy, Windows partition, or something
else as a normal user, add the user option into /etc/fstab.
exec and noexec exec lets you execute binaries that are on that partition,
whereas noexec doesn't let you do that. noexec might be useful for a partition
that contains binaries you don't want to execute on your system, or that can't
even be executed on your system. This might be the case of a Windows partition.
exec is the default option, which is a good thing. Imagine what would happen if
you accidentally used the noexec option with your Linux root partition...
ro Mount the file system read-only.

rw Mount the file system read-write. Again, using this option might cure the
headache of many new Linux users who are tearing their hair off because they
can't write to their floppies, Windows partitions, or something else.

sync and async How the input and output to the file system should be done. sync
means it's done synchronously. If you look at the example fstab, you'll notice that
this is the option used with the floppy. In plain English, this means that when you,
for example, copy a file to the floppy, the changes are physically written to the
floppy at the same time you issue the copy command.
However, if you have the async option in /etc/fstab, input and output is done
asynchronously. Now when you copy a file to the floppy, the changes may be
physically written to it long time after issuing the command. This isn't bad, and
may sometimes be favorable, but can cause some nasty accidents: if you just
remove the floppy without unmounting it first, the copied file may not physically
exist on the floppy yet!
async is the default. However, it may be wise to use sync with the floppy,
especially if you're used to the way it's done in Windows and have a tendency to
remove floppies before unmounting them first.

defaults Uses the default options that are rw, suid, dev, exec, auto, nouser, and
async.
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< 5TH AND 6TH COLUMNS: DUMP AND FSCK OPTIONS >
Dump and, uh, what options? Well, dump is a backup utility and fsck is a file
system check utility. I won't discuss them in great length here (they would both
need their own tuXfile), but I'll mention them, because otherwise you'd spend the
rest of the day wondering what on God's green Earth do these things mean.
The 5th column in /etc/fstab is the dump option. Dump checks it and uses the
number to decide if a file system should be backed up. If it's zero, dump will
ignore that file system. If you take a look at the example fstab, you'll notice that
the 5th column is zero in most cases.
The 6th column is a fsck option. fsck looks at the number in the 6th column to
determine in which order the file systems should be checked. If it's zero, fsck
won't check the file system.

< EXAMPLE /ETC/FSTAB ENTRIES >
As an example, we'll take a look at a couple of fstab entries that have been a
source of endless frustration for new Linux users: floppy and CD-ROM (although
these days floppies aren't that important anymore).
/dev/fd0 /media/floppy auto rw,noauto,user,sync 0 0

This line means that the floppy is mounted to /media/floppy by default and that
its file system type is detected automatically. This is useful because the type of
the floppy may wary. Note especially the rw and user options: they must be there
if you want to be able to mount and write to the floppy as a normal user. If you
have trouble with this, check your fstab file to see if these options are there. Also
note the sync option. It can be async just as well, but it's sync because of reasons
discussed a bit earlier.
/dev/cdrom /media/cdrom auto ro,noauto,user,exec 0 0

Note, again, the user option that enables you to mount the CD as a normal user.
The CD-ROM has the ro option because it's no use mounting a CD-ROM readwrite because you wouldn't be able to write to it anyway. Also note the exec
option. It's especially useful if you'd like to be able to execute something from
your CD.

Also note that the noauto option is used with the floppy and CD-ROM. This
means that they won't be automatically mounted when your Linux system boots
up. This is useful for removable media, because sometimes there won't be any
floppy or CD-ROM when you boot up your system, so there isn't any reason to try
to mount something that doesn't even exist.

Kopete to IRC Howto
by Rifter

1. Start Kopete
2. Right-click on the Kopete icon in the kde system tray area and select configure
OR if the Kopete window is open, under the settings menu, go down to configure
3. Once the configure menu is open, make sure accounts is selected in the sidebar
4. Click the New button in the accounts area
5. Select IRC from the list of protocols and click Next
6. Make sure the basic setup tab is highlighted.
7. Type in what you want to be called in channel in the Nickname box and what
you want to be called if your other nickname is taken in the Alternate Nickname
box.
8.Click the Connection tab
9. Click the network drop-down list, and select FreeNode
10. Click Next
11. Make sure the Connect Now box is highlighted
12. Click Finish
13. Right-click on the Kopete icon in the system tray area and highlight the new
irc network name OR click on its icon in the lower right-hand corner of the Kopete
window.
14. In the sub-menu that appears in either case, click on the entry Join Channel.
15. Type "#PClinuxOS" without the quotation marks into the box that appears16.
Click Ok
17. Chat
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CHAPTER 8: THE WORLD WIDE WEB (WWW)
The Internet has much to offer in terms of information on almost any subject
matter imaginable and interaction with people and organizations from all over the
world. Much of this access and interaction make use of the environment which is
popularly known as the World Wide Web (WWW) or web. The WWW is an interlinked
network of systems, called web servers, offering multimedia services and
information. A user can access these using what is known as web browser
software.

THE MOZILLA FIREFOX WEB BROWSER
Firefox is a full-featured integrated web browser, news reader and web page
composer program, and is the default web browser for PCLinuxOS 2007. Using
Firefox a user can be exposed to the richness and diversity of multimedia content
and services available on the WWW.

Firefox is a relatively lightweight and fast browser. The most distinguishing and
advantageous feature is the sheer number (literally hundreds) of extensions (addons) that can be downloaded and installed. Using these add-ons; the user can
personalize Firefox exactly how they want Firefox to be. For more information and
descriptions of the over one thousand available add-ons take a look at
http://www.firefox.com/firefox.
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To start Firefox, click on the Firefox icon on the panel or launch the application
from the menu system:
Main Menu -> Internet -> Web Browsers -> Mozilla Firefox

Fig. The Firefox Web Browser

By default the web browser component of Firefox will be executed and displayed.
The navigation window has the following main parts by default.
the
the
the
the

navigation toolbar
menu bar
display panel
side bar (optional)

(Firefox has many features and only a brief description of its main functionalities
and features can be given here. The user should refer to the Help button on the
menu bar for more details.)

THE NAVIGATION TOOLBAR
The navigation toolbar allows you to access a website by entering its Uniform
Resource Locater (URL) or more informally known as its web address, e.g.
http://Distrowatch.com in the address box provided. Actually you need to enter
only the name of the host i.e. “Distrowatch.com” and Firefox is smart enough to
figure out that you want to access the web server on that host.
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Fig. The Navigation Toolbar

Clicking on the arrow at the right edge of the address box will open a pull-down
menu showing a history of websites visited previously. You can click on an entry
in the list to select that website.
Also present on the navigation toolbar are the Back, Forward, Reload and Stop
buttons.
The Back button enables you to go back to the previous web page displayed.

The Forward button enables you to go forward to the next web page that you have
already accessed.
The Reload button forces Firefox to re-access the website and load the current
web page.
The Stop button halts the loading of a web page that is currently proceeding.

Next to the address box in the navigation toolbar is the Search button. This
button enables you to perform searches for relevant web pages on the Internet by
making use of the Google search engine. To search for some particular
information, you can enter the keywords for the search into the address box and
then click on the Search button. As you type each letter a list of possible searches
will be displayed below the search box. Quite often, what you are searching for
will show up in the list before you finish typing. If so, simply click on the one you
want to try. The results of the search will be displayed in the display panel. You
can configure the search engine to use with this search button in the Firefox
configuration setup (see Configuring Firefox below).

THE MENU BAR
Fig. The Menu Bar

The menu bar has several menu buttons. Clicking on one will open up a dropdown menu selection where selected operations can be performed.

The File button caters to the performance of file level operations like the printing
and saving of web pages, the opening of web pages, files etc.

The Edit button allows you to find strings of text on the displayed page as well as
to edit the Firefox configuration to you personal preferences.
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The View button allows you to control the viewing of the various toolbars as well
as the zooming of text and full page display of the display panel. The HTML
source code of the currently displayed page can also be viewed using the
selection “Page Source” under this button.

The History button performs similar navigational functions as the navigation
toolbar described earlier. A history of previously visited sites can also be accessed
by this button. The menu shows a list of previously visited websites and you can
click on one of these to open up the selected web page.

Fig. The History Pop-up Window

The Bookmarks button enables you to manage your bookmarks and personal
folder. You can add frequently visited sites to the bookmark and/or personal
folder. To manage and organize your bookmarks you can select the "Organize
Bookmarks" item in the drop-down menu.

Fig. The Bookmark Manager Pop-up Window

The bookmarks can be organized into folders by dragging and dropping them
into the desired folder. New folders can be created by clicking on the New Folder
button at the top. Folders can have a name and description. To separate and
group together related folders, a separator line can be drawn by selecting the
"New Separator" button.
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The Tools button enables you to navigate and use specific tools and add ons in
Firefox.
The Help button contains the Firefox help files arranged in user-friendly web
page style and format.

THE SIDE BAR
Under the View button you will find an option to add a side bar. The Side Bar is
displayed on the left of the main display panel. This side bar can display your
History, or your Bookmarks for quicker access.
The side bar can be turned on/off by selecting from the main menu at the top,
View -> Sidebar

THE MAIN DISPLAY PANEL
This is the area where the contents of a web page are rendered and displayed.
This display area can be made full screen by either selecting the View -> Full
Screen selection from the top menu bar or pressing the F11 key. To disable full
screen display either press F11 again or click on the "Restore" window button on
the top right corner of the menu bar.

NAVIGATION TAB BAR
Firefox allows you to browse multiple websites within one browser window by
using navigational tabs. This overcomes the inconvenience of opening several
windows under Firefox to view multiple sites. To do this, either choose under the
menu bar:
Edit -> Preferences ->Tabs ->New Pages Should Be Opened In ->A New Tab
or enter CONTROL-T.

If you open different web pages using this navigation tab feature, they will all be
displayed under the same window. You can then use the tab bar to move between
each tab screen.

CONFIGURING FIREFOX
Firefox is highly configurable. To configure Firefox, select from the main menu:
Edit -> Preferences
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The categories available for configuration are listed on the top panel of the main
configuration window as seen below:

Fig. Firefox Preferences

The Main tab allows you to set your homepage and where to save files that you
download.
The Tabs tab allows you to set all the options related to tabbed browsing.

The Content tab lets you block pop-ups, whether you would like to have images
load automatically, and java script control. You can also set your default fonts and
configure how Firefox handles different file types.
The Feeds tab allows you to choose which feed reader to use when accessing live
feeds from the Internet.
The Privacy tab lets you manage your History, Cookies, and Personal Data.

The Security tab allows management of passwords for different websites, warning
messages, and whether websites are real or not.
The Advanced tab lets you control encryption, updates, and navigation within
web pages.
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EXERCISES
1. Start up the Firefox browser and visit the websites listed below. Use the
navigation tab bar feature so that you open up the websites all in the same
window, but under different tab pages.
www.Firefox.org
www.yahoo.com

2. Bookmark the sites visited above.
3. Configure Firefox so that it starts with your preferred homepage.
4. Finding Information on the Internet

The Internet is a treasure house of information. Information on virtually any topic
under the sun (and more!) can be found on the Internet. However, while
information is easily available, it may not be so easy to find the information you
want. This is because the information may be available from very many sites,
often in varying details, and varying aspects of the same piece of information. To
assist us in finding information more effectively, a search engine or Internet
portal may be used.

Note: Information obtained from the Internet should be scrutinized carefully and
not taken as “correct” in all cases. This is because due to its free flowing nature
and easy means of access and creation, anyone can publish information on the
Internet. As such, unless one is certain that the information is from an
authoritative and reliable source, it should be verified by another source or means
as far as possible.

USING A PORTAL
The term portal is used to denote a website that acts as an gateway for providing
information about a subject area or group of subjects. From this portal site,
information as well as links to other sites providing information about the topics
in question may be found. Portals are useful starting places for new web users
who do not know where and how to go and look for information about a specific
topic or subject.
Many major ISPs provide portal-like information services for their subscribers so
that if the latter make this their home page for their web browser, on launching
their browser the ISP's portal page is opened. The subject areas covered by these
ISP portals are typically subjects of general interest like shopping, local and
foreign news, entertainment etc.
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Fig. Home Page for an ISP

Other portals offering general information as well as links to other more subjectspecific portals and websites include:
Yahoo (www.yahoo.com)
Netscape Network (www.netscape.com)
Microsoft Network (www.msn.com)
Angelfire (www.angelfire.lycos.com)

USING AN INTERNET SEARCH ENGINE
While portals provide a guided and categorized means to access information,
sometimes we want to be more specific about the topic we want to find and
portals generally are not able to provide this in a timely and efficient manner. An
alternative is to utilize a search engine.
A search engine, as the name implies, allows you to query it about some specific
subject and it will try to retrieve links to web pages and resources which contain
information about the subject matter being queried.
The popular search engines available are:
Google (www.google.com)
Altavista (www.altavista.com)
Lycos (www.lycos.com)
Yahoo (www.yahoo.com)
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There are also sites which allow you to search using more than one search engine,
e.g.
Search.com (www.search.com)
Easysearcher (www.easysearcher.com)

SEARCH BASICS
While each search engine will have its own technology, its utilization to perform a
simple and basic search is essentially the same, irrespective of which search
engine is used.

To use a search engine for basic searches, you just type in a few descriptive words
about the item/subject you are searching for. It will return to you a list of links to
web pages and resources which contain all the words in the query string. Note
that common words like "the", "a", "how", etc. are usually ignored by the search
engine unless specifically told not to. Words are also not case sensitive unless
enclosed by quotation marks. To refine and narrow down your search, you will
need to add more words to the search terms you have already entered. Your new
query will return a smaller subset of the pages found.

Fig. A Search Engine

The basics of using current search engines is essentially keyword matching and so
it is important to be able to identify appropriate keywords so that your search is
more efficient and false hits are minimized. The keywords entered should be as
specific as possible in order to get better results.
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More details on how to use each particular search engine are available on their
respective websites and they should be consulted so that you can make efficient
use of them.

EXAMPLE
In this section we shall show an example of how to use a search engine.

In this example, assume that we have heard from a friend that she has been
diagnosed with a foot condition in which her forefoot is in pain and there is
numbness as a result of poor blood circulation in one of the toes. We also
remembered her telling us that the doctor named the condition as Freiberg
disease, or some name which sounds like that since the telephone line was not
too clear.

Initially we try entering the following keywords, "foot pain", in the search engine.

Fig. Search using Common Keywords

As can be seen from the results of the search, what we got back was very general
and we need to go through each of these links to check if it contains relevant
information or links to relevant information. We can narrow down the search if we
are more specific about where in the foot the pain is, e.g. "forefoot pain." This will
give us better results, but the list of hits is still long.
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Fig. Search using Relevant Keywords

If we remember that the friend mentioned that the doctor gave the name of the
condition as something sounding like Frieberg disease, we can try searching for
this specific term. The search results improve immediately as can be seen below
and in this particular example we have found several links which are directly
related to the information we want.

Fig. Refined Search using Specific Keywords

That is the end of this chapter in our journey into the inner workings of KDE and
PCLinuxOS 2007. In our next chapter we will be covering all of the ins and out of
Internet e-mail including how to setup an e-mail account, manage your mail, and
a couple of different e-mail clients. See you next month!

I'm in Your Leenux Box Changing Your Password
by Scrap

at http://blogs.ittoolbox.com/security/investigator/archives/im-in-yourleenucks-box-changing-your-password-17600
So I've been a professor at this 'little school' for a while now. I love my job. My
classes contain students from all age groups. I have a few 17 year old high
schoolers that are here because they are bored during the summer. I have a few
seasoned folks that have IT experience. I also have a few people that are clearly
here just for the three credit hours.

The classroom is set up in a 'lab' environment. Each student has a PC in front of
them that netboots linux from a central box located near my desk at the front of
the classroom. This setup works great because the students come into the
classroom every day, power on their PC, and they get the exact OS load and
lesson they need for our session. Not to gloat, but I designed it this way and I'm
the envy of a few other professors *cough* Windows instructors *cough*.
I have this one student that I'll call "Pima". Yes, that's an acronym.

Pima is one of the 17 year olds in the class and considers himself an uber-hax0r.
He constantly interrupts me during my lessons trying to make valid points that
are somewhere between "WHAT?" and "OMG YOU ARE NOT USING THE DEBIAN!".
For those of you that listen to the podcasts and remember my story about training
some folks over in another country and some dude put my kevlar vest over top
his... well, let's say if we were in combat and this kid dropped his kevlar I think I'd
dig a hole and bury it so he couldn't find it.
This kid has the attention span of me at a Hooters restaurant. He's always doing
"something" on his PC during class. Most of the time he's constructing poorly
written bash scripts and trying to download stuff from an internet connection that
really doesn't exist. I didn't say he was bright, did I? Right.

One day recently we had a special Saturday class that was very lab intensive. Right
before the lunch break, I informed everyone that I'd be going around to each PC
and "breaking" something that they'd have to fix when they got back. Usually I do
something silly like screw with their /etc/resolv.conf file, comment out some
things in a service's configuration file, or some other type of fun.
During the lunch hour, I wander around and start breaking stuff. When I got to
Pima's machine and I can't login to the machine as root. My little uber-hax0r had
changed the root password.
[Note from Scrap: All students have the root password to their workstations as
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part of their lesson]

Let's keep in mind that this kid is NOT the ripest banana in the bunch by a long
shot. Let's think about this, shall we?
1) The PC neboots to an image. Changing the root password is effective for the
current 'session' only. I reboot the machine, I get a fresh load. Kapisch?

2) SSH is running on all of these boxes. Did I mention that I authenticate using a
certificate to all of these machines? I don't NEED the password.
3) In /etc/passwd, there's this really cool user called (and I kid you not)
"backdoor". Backdoor is authorized for 'su'.

Curiosity was killing me. I tried to login as "backdoor" and sure enough it worked
and I could issue commands as root. Duh.

I wandered back to my instructor workstation and ssh'd to his box as root with no
problems.
I had a decision to make. Do I just reboot the machine and carry on? Or do I teach
this kid a lesson?
Oh yeah, he's getting a lesson.

I whipped out my microphone from my laptop bag and plugged it into my
workstation. I recorded a few choice sound files and scp'd them to his workstation
in a directory I made called "/tmp/.../lmao".
I then made sure that 'sox' was installed on the workstation. It was. I ran back
over to Pima's workstation and made sure that the speaker volume was turned to
75% on his speakers. Just to be a jerk I used my trusty pocketknife to pry the
volume knob off of the speakers. There will be no adjusting these bad boys!
The clock said that I had half an hour left before the students returned, so I
quickly returned to breaking the rest of the students' workstations.
A half hour later it was show time.

The students filed back into the classroom. Pima was five minutes late as usual.
I instructed the class not to touch their keyboards until I gave them their
instructions.

After I prattled on for five minutes with the assignment I sat back down at my
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workstation and acted like I was busy. I noticed that Pima had a big grin on his
face after he logged into his machine with his root password. The grin said "haha
you didn't break MY stuff!".
I brought up the xterm that was ssh'd into Pima's workstation and issued the
following commands:
$ cd /tmp/.../lmao
$ play haha1.wav

At that moment a loud booming voice commanded its way from Pima's speakers:
YOU SHOULDNT HAVE CHANGED MY ROOT PASSWORD BOY!

There was dead silence in the room. Pima jumped back about half a foot from his
PC.
Laughter ensued.

I glanced up from my screen and glared at Pima.

"Is there a problem? You should be working on your assignment and not goofing
around."
Pima squeaked out a "It wasn't MEEEEE!"

I glanced back down at my screen and waited another few minutes.
I then issued this:
$ play haha2.wav

The class was treated to a very high-pitched chimpmunk version of "MY HUMPS!
MY HUMPS! MY ITTY BITTY HUMPS!"
At this point the class was dying in laughter.
I continued with my straight man act.

"Pima, if you interrupt this class one more time I'm walking you out. Have some
respect."
He sat there and didn't say A WORD.

A few more minutes go by and Pima is typing like a mad man on his keyboard
trying to figure out what the heck is going on.
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It was now time for "Le Finale Grande".
$ play haha3.wav

Pima's speakers blared the following in my own God-like voice:

"ATTENTION CLASS. THIS IS WHAT HAPPENS WHEN YOU DONT PAY ATTENTION TO
THE INSTRUCTOR, CHANGE YOUR ROOT PASSWORD AND COMPLETELY DISREGARD
YOUR ASSIGNED WORK. THAT IS ALL."
At that moment Pima figured it out and was treated to his classmates (and me)
laughing hysterically at him. He stood up, put his arms up in the air and
proclaimed "YOU GOT ME. YOU GOT ME. OKAY."
Pima has been a perfect gentleman since.

He even shows up to class five minutes early every day.
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Disclaimer
1. All the contents of PCLinuxOS Magazine (pclosmag.com) are only for general
information and/or use. Such contents do not constitute advice and should not be
relied upon in making (or refraining from making) any decision. Any specific
advice or replies to queries in any part of the magazine is/are the personal
opinion of such experts/consultants/persons and are not subscribed to by
PCLinuxOS Magazine.
2. The information in PCLinuxOS Magazine (pclosmag.com) is provided on an "AS
IS" basis, and all warranties, expressed or implied of any kind, regarding any
matter pertaining to any information, advice or replies are disclaimed and
excluded.

3. PCLinuxOS Magazine (pclosmag.com) and its associates shall not be liable, at
any time for damages (including, without limitation, damages for loss of any kind)
arising in contract, tort or otherwise from the use of or inability to use the
magazine, or any of its contents, or from any action taken (or refrained from
being taken) as a result of using the magazine or any such contents or for any
failure of performance, error, omission, interruption, deletion, defect, delay in
operation or transmission, computer virus, communications line failure, theft or
destruction or unauthorised access to, alteration of, or use of information
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4. No representations, warranties, or guarantees whatsoever are made as to the
accuracy, adequacy, reliability, completeness, suitability, or applicability of the
information to a particular situation.

5. Certain links on the magazine lead to resources located on servers maintained
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